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NEW QUESTION 1
- (Exam Topic 1)
You need to configure functionality for submitting status reports. What should you do?

A. Determine whether the application is offline when a user selects submit button and call the Sec () function.

B. Determine whether the application is offline when the app load

C. Use the SaveDaca () function in the OnSelect property.

D. Determine whether the application is offline when a user selects the submit button and call the SaveDaca () function.
E. Determine whether the application is offline when the app load

F. Use the LoadDaca () function in the Submit button.

Answer: C

Explanation:

Scenario: The app must be able to run both online and offline. If the mobile device on which the app runs is connected to the internet, the app must immediately
submit the status report.

When data is submitted offline, the data must be stored in the app until the app is back online. Mobile users often need to be productive even when they have
limited or no connectivity.

LoadData and SaveData combine to form a simple mechanism to store small amounts of data on a local device. By using these functions, you can add simple
offline capabilities to your app.

The SaveData function stores a collection for later use under a name.

The LoadData function reloads a collection by name that was previously saved with SaveData. You can't use this function to load a collection from another source.
Reference:

https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/functions/function-savedata-loaddata

NEW QUESTION 2

- (Exam Topic 1)

You need to resolve the issue for Userl.

What should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Requirement Option

Submit a status report. v

Dynamics 365 mobile app
Power Apps Studio
Power Apps mobile app
Azure mobile app

Edit an existing status report. v
Azure SQL Database
Connector
SQL Lite DB
Collections
A. Mastered

B. Not Mastered
Answer: A

Explanation:

Graphical user interface, text, application Description automatically generated

Box 1: Power Apps mobile app Scenario:

Userl often works in a warehouse that does not have internet connectivity. Userl needs to edit an existing status report and submit a new status report.
The app must be able to run both online and offline. If the mobile device on which the app runs is connected to the internet, the app must immediately submit the
status report.

You can build offline capabilities in your PowerApps app So your app users can access some data or save some data even when they don't have an internet
connection.

Box 2: Connector

Scenario: Azure SQL Database is used to store other data

Use the SQL Server connector to connect to SQL Server, in either Azure or an on-premises database, so that you can manage your data with create, read,
update, and delete operations.

Reference:

https://powerapps.microsoft.com/en-us/blog/implementing-offline-capability-in-your-app/

NEW QUESTION 3

- (Exam Topic 1)

You need to modify the app design to meet the accessibility needs of the sales associates.

Which properties should you configure? To answer, drag the appropriate properties to the correct restrictions. Each property may be used once, more than once,
or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.
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Properties Restriction Property
Tablindex

DisplayMode Design for User2

AccessibleLabel Design for User3

Tooltip

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Graphical user interface, text, application Description automatically generated

Box 1: AccessibleLabel

Scenario: Before deploying the app to production, you must ensure that the app conforms to Microsoft accessibility and performance guidelines.
User2 is visually impaired and cannot see images. AccessibleLabel is a label for screen readers.

An empty value for Image, Icon, and Shape controls will hide the controls from screen reader users. Box 2: TabIndex

User3 is unable to use a mouse.

Tablndex determines if the control participates in keyboard navigation.

Keyboard navigation is an important aspect of any app. For many, the keyboard is more efficient than using touch or a mouse. The navigation order should:
Mirror what is seen visually.

Only have a tab stop at controls that are interactive.
Follow either an intuitive across and then down "Z" order or a down and then across "reverse-N" order.

NEW QUESTION 4

- (Exam Topic 1)

You need to roll back the mobile app to an earlier version.

What should you do? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
Answer Area

Regquirement Action

Identify the currently published version and view version notes. | [l

\View the session details page for the app in Power Apps Studio.
{View environment details for the app in the Power Admin portal,
|Wiew details for the app in the Power Apps Maker portal.

Revert to an earlier version of the app. [ v

[Select Restore on the previous version of the app.
|Export the previous version of the app and import as a new version.
|Delete versions of the app until the desired version is the most recent.

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Box 1: View the sessions details page for the app in Power Apps Studio

Use PowerApps Studio, select the App, and choose and you will be directed to the app’s Versions tab in PowerApps portal. There should be one version marked
Live.

Detalls - Share « Versions « Settings

PowerApps keeps a version hestony of your apps

F
VERSION MODIFIED MODIFIED BY POWERAPPS RELEASE! 7 ) PUBLISHED COMMENT

1 6/7/2017 9:01:43 AM Karthik Bharathy 2.0.659 [ Live ]

Box 2: Select Restore on the previous version of the app. Restore an app from your account

> Open powerapps.com, and then click or tap Apps in the left navigation bar.

> Near the right edge, click or tap the info icon for the app that you want to restore.

> Click or tap the Versions tab, and then click or tap Restore for the version that you want to restore.

Your Partner of IT Exam visit - https://www.exambible.com



We recommend you to try the PREMIUM PL-100 Dumps From Exambible
exam blb|@ https://www.exambible.com/PL-100-exam/ (171 Q&AS)

Details -« Share . Versions « Settings -« Analytics (preview)

1]
1
[ &
L1t
A

VERSION MODIFIED MODIFIED BY PDWEPAPPSREIE&SE@ PUBLISHED COMMENT

2 87202018 2:24:29 PM  Firstname Lastname  3.18081.19 Live

z
1 7/9/2018 10:55:48 AM  Firstname LastName 3.18071.36 () Restore | [H] Delete

Reference:
https://powerapps.microsoft.com/sk-sk/blog/saveandpublish/ https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/restore-an-app

NEW QUESTION 5

- (Exam Topic 1)

You need to ensure that the app can support the needs of User2 and User3, and meets the production deployment requirements.

Which tools should you use? To answer, select the appropriate tool in the answer area. NOTE: Each correct selection is worth one point.

Tools Answer Area

Solution Checker Requirement Tool
App Checker Accessibility

Object Detector
: Deployment

Preview the app

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: App Checker

Scenario: Several sales representatives have accessibility restrictions. User2 is visually impaired and cannot see images. User3 is unable to use a mouse.
Users who have vision, hearing, or other impairments can use your canvas app more easily and successfully if you consider accessibility as you design how the
app looks and behaves. If you're not sure how to make your app more accessible, you can run the AppChecker Accessibility checker in Power Apps Studio.
Box 2: Solution Checker

Scenario: Before deploying the app to production, you must ensure that the app conforms to Microsoft accessibility and performance guidelines.

Use solution checker to validate your model-driven apps in Power Apps. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/accessibility-checker https://docs.microsoft.com/en-us/powerapps/maker/common-data-
service/use-powerapps-checker

NEW QUESTION 6
- (Exam Topic 2)
You need to connect to the data source for the Job Setup app. What should you do?

A. Configure a scheduled synchronization with the Common Data Service database
B. Configure SQL Server database permissions

C. Create a stored procedure that retrieves time records for a specific employee

D. Configure an on-premises data gateway

Answer: D

Explanation:

Scenario: The Job Setup entity must store its data in the existing on-premises SQL Server instance.

The on-premises data gateway acts as a bridge to provide quick and secure data transfer between onpremises data (data that isn't in the cloud) and several

Microsoft cloud services. These cloud services include Power Bl, Power Apps, Power Automate, Azure Analysis Services, and Azure Logic Apps. By using a
gateway, organizations can keep databases and other data sources on their on-premises networks, yet securely use that on-premises data in cloud services.
Reference:

https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/gateway-reference

NEW QUESTION 7

- (Exam Topic 2)

You need to create the solution assets.

What should you use to create the visualizations? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.
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Dashboard visualization Tool

Sales | _ _ v
Power Bl Desktop only
Power Bl Service only
Power Bl Desktop or Power Bl Service

Manufacturing v |
Power Bl Desktop only
Power Bl Service only
Power Bl Desktop or Power Bl Service

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: PowerBI Desktop

The Sales dashboard must reside in the Sales channel and must include information about active quotes, sales pipeline, and year-to-date sales KPIs for sales
guotas by region.

PowerBI Desktop to support many data source. Box 2: PowerBI Desktop or Power Bl Service on

A dashboard that shows a capacity Heat map by month as well as expected sales that are likely to close for the next month.

Both support visualizations. Reference:

https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop

NEW QUESTION 8

- (Exam Topic 2)

You need to meet the requirement for the time tracking app.

Which controls should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

Answer Area

Requirement Solution

Automatically record the duration of work when a job number is read. e v
|Card
Rating
Slider
Timer

Barcode-scanner
Card

Image

Shape

Read the employee's number into the app. ) =

Display a photo of an employee when the employee badge is read. [—— NEd
Camera
Card
lcon
Image

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: Timer

A Timer control in Power Apps is a control that can determine how your app responds after a certain amount of time passes.

Box 2: Barcode scanner

The Barcode scanner control for canvas apps scans barcodes, QR codes, and data-matrix codes on an Android or iOS device.

Box 3: Image

Image control in Power Apps is a control that shows an image from, for example, a local file or a data source. If you add one or more Image controls to your app,
you can show individual images that aren't part of a data

set, or you can incorporate images from records in data sources.

Reference:

https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/controls/control-new-barcode-scanner https://docs.microsoft.com/en-us/powerapps/maker/canvas-
apps/controls/control-image

NEW QUESTION 9

- (Exam Topic 2)

You need to resolve the user’s issue with the time tracking app.

Which two actions should you perform? Each correct answer presents part of the solution.
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NOTE: Each correct selection is worth one point.

A. Add a component to the time tracking screen for tracking total time.

B. Create a new component inside of the component library for the time tracking app.

C. Upload the component to AppSource.

D. Add the Total Time field to the screen and set the value of the field property to Rollup

Answer: AB

Explanation:

Scenario Issue: Users want to be able to see their weekly total time entered from all screens.

A component library provides a centralized and managed repository of components for reusability. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/component-library

NEW QUESTION 10

- (Exam Topic 3)

An automobile company uses Power Apps. The company uses a model-driven app to manage customers and repairs.

The Customer table has a custom column of type text named Best time to call. On the Repair form, employees require the Best time to call column to be displayed
next to the customer name.

You need to modify the model-driven app to display the Best time to call column. Which two steps should you perform? Each correct answer presents part of the
solution. NOTE: Each correct selection is worth one point.

A. Add The Best time to call column to the quick view Repair form.
B. Create a quick view form for the Repair table.

C. Create a quick view form for the Customer table.

D. Add the Best time to call column to the quick view Customer form.

Answer: CD

NEW QUESTION 10

- (Exam Topic 3)

You create an automated flow by using Power Automate. The flow appears under My Flows and is connected to the development environment. The development
environment has a solution to move components into a production environment.

You need to ensure that you can transfer the flow to another environment. What should you do?

A. Add the flow to the default solution of the development environment and export as a managed solution.
B. Change the environment for the flow.

C. Add the flow to the existing solution.

D. Add the flow to the default solution of the production environment.

Answer: A

Explanation:

It is very normal for a developer to build the power automate in one environment and then export that automate & import it to another destination environment.
Exporting our Solution

After validating our flows work in our test environment, we now want to promote it to our production environment. We can export our solution by finding it in our
Solutions experience, clicking on the ..., selecting Export.

Graphical user interface, application, Teams Description automatically generated

H#i | Flow

,-.1 Lot el

Reference:
https://flow.microsoft.com/en-us/blog/solutions-in-microsoft-flow/

NEW QUESTION 15

- (Exam Topic 3)

You are creating an app for a company. You need to evaluate the default solution.

Which two behaviors should you expect from the default solution? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. You can change the prefix of the publisher of the default solution

B. If you create a Power Automate flow in a solution, the flow uses the prefix defined in the publisher

C. If you create an environment variable in a solution, the variable uses the prefix defined in the publisher
D. You can change the version number of the default solution

Answer: AC
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Explanation:
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/use-solutions-for-y

NEW QUESTION 17

- (Exam Topic 3)

A company creates an app that uses Microsoft Dataverse tables.

The app creator wants to verify that the app is operating as expected by using a sample set of real-world data. You need to import the sample data into Dataverse
tables.

Which two technologies can you use? Each correct answer presents a complete solution.

NOTE: Each correct selection is worth one point.

A. Power Bl

B. SharePoint
C. Power Query
D. Dataflows

Answer: CD

Explanation:

C: You can create a table in Dataverse and fill that table with data from an OData feed by using Power Query. You can use the same techniques to integrate data
from these online and on-premises sources, among others:

SQL Server Salesforce

IBM DB2

Access Excel Web APIs

OData feeds Text files

D: You can create a new Dataverse table that stores all the metadata from the dataflow run. For every refresh of a dataflow, a record is added to this table. You
can also store metadata for multiple dataflow runs in the same table.

Reference:

https://docs.microsoft.com/en-us/power-query/dataflows/load-dataflow-metadata-into-dataverse-table https://docs.microsoft.com/en-us/power-query/dataflows/add-
data-power-query

NEW QUESTION 22

- (Exam Topic 3)

You create a canvas app nhamed Hardware Order that suggests computer hardware to customers.

A value must be entered for the EmployeelD field when creating a new order if the value in the OrderType field does not contain the prefix test.
You need to configure the business rule.

Which two actions should you perform? Each correct answer presents part of the complete solution.

NOTE: Each correct selection is worth one point.

A. Set the scope of the business rule to Entity.

B. Add a Recommendation action and configure it to enter the order type.

C. Set the scope of the business rule to All Forms.

D. Use the following condition expression:(OrderType Does not begin with [test]) AND (Modified By Does not contain data)

Answer: AD

Explanation:
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/data-platform-create-business-rule

NEW QUESTION 27

- (Exam Topic 3)

DRAG DROP

A company uses Microsoft Power Platform. Users create charts based on specific needs in the production environment. Users cannot create system charts in
production.

You create a solution in a development environment. You rebuild personal charts of the users inside the solution. All charts must appear on one page.

You need to create a single page that includes all charts without switching to classic.

Which three steps should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

Actiom Arswar Ares

© ¥

A. Mastered
B. Not Mastered

Answer: A

Explanation:
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Actions Antwer Ared

NEW QUESTION 32

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You build a canvas app for a manufacturing company. The company receives parts and materials from many vendors. You create a form to collect information
from packing slips.

Receivers must be able to take a picture of packing slips to receive materials instead of manually entering data in the app.

You need to ensure that users can scan packing slip information into the form. Proposed solution: Use a Key Phrase Extraction model.

Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation:
The key phrase extraction prebuilt model identifies the main points in a text document. Reference:
https://docs.microsoft.com/en-us/ai-builder/prebuilt-key-phrase

NEW QUESTION 37

- (Exam Topic 3)

A company uses several forms for biannual performance evaluations. The company conducts the evaluations by using a pen and paper process. The evaluations
contain several performance areas that have a score of 1-10. A paragraph explains the score.

The company must scan completed performance evaluations into a Common Data Service entity by using a Power Apps app. The information in the documents
must automatically map to entities and convert into quantifiable information.

If any key phrases in the scored topics cause concern, the company must follow a series of actions to prepare for a follow up.

You need to extract the information and perform the actions when the evaluations are scanned. Which component should you use? To answer, select the
appropriate options in the answer area. NOTE: Each correct selection is worth one point.

Requirement Component
Convert the evaluations from images to data hd
Al Builder
Power Bl
Dataflows

Business rules

Convert a form processing variable to an A 4
integer Initialize variable

Add dynamic content

Append to string variable

Extract entities and their types from text

—

Use the flow action to convert a form l \4
processing variable to an integer Scope
Do until
Condition
t Apply to each
A. Mastered

B. Not Mastered
Answer: A

Explanation:

Graphical user interface, text, application, table, email Description automatically generated

Box 1: Al Builder

The object detection component of Al Builder for PowerApps takes a photo or loads an image file to do an object detection scan. On a mobile device, the user
chooses between taking a photo or selecting one already available in the device user interface. When an image is selected, the component automatically scans it
to identify objects.

Box 2: Extract entities and their types from text

The Entity extraction prebuilt model identifies and classifies key elements from text into pre-defined entities. You can use the prebuilt model out of the box in power
apps and power automate.
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Box 3: Scope
Scope is a simple way to put similar actions and conditions together like a Stage. Reference:

https://docs.microsoft.com/en-us/ai-builder/object-detector-component-in-powerapps https://powerapps.microsoft.com/en-us/blog/new-ai-builder-models-are-now-

generally-available/

NEW QUESTION 42
- (Exam Topic 3)

A user named Bill Jones creates a canvas app and shares it with other users in his company as shown in SharePowerUsers and ShareJimSmith exhibits. (Click

the SharePowerUsers tab and the ShareJimSmith tab.)

Share Company App

Enter a name, email address, or Everyone Power Users
This User can use this a
Shared with Sort by Name - e 24
L Co-owner
@ Bill Jones Can use, edit, share app but not delete or change owner
Data permissions
@ Jim Smith " P ©
Co-ownel Make sure your users have access to the data used in your app, including gateways,
APls, connectors, and enlities
®© @ Power Users W
Liser
Share Company App
Enter a name, email address, or Everyone Jim Smith
This User can use this a
hared with Sort by Name i i 2
« | Co-owner
e Bill Jones Can use, edit, share app but not delete or change owner
Data permissions
° Jim Smith ~ perismons
Co-owner : Make sure your users have access to the data used in your app, including gateways,

APIs, connectors, and entities

@ Power Users v

There are multiple versions of the app. Users must only be able to run the most recently published version of the app as shown in the table below:

Version | Modified Modified | PowerApps | Published | Version note
by release

Version 4 | 09/05/2020 17 32 BillJones | 3200238 Changed
fonts

Version 3 | 09/05/2020 17:30 Bill Jones | 3200238 Live Changed
business
logic

Version 2 | 09/05/2020 17:22 Bill Jones | 3200238 Updated
background
color

Version 1 | 09/05/2020 17:20 BillJones | 3200238

You need to ensure that sharing is configured correctly.
For each of the following statements, select Yes if the statement is true. Otherwise, select No.
NOTE: Each correct selection is worth one point.

Yes

Member of the Power Users group are able to publish version 4 of the canvasapp. O

When using the canvas app, a member of the Power Users group can see version4. O

If version 2 of the canvas app is restored, it will be labelled as the Live version O
If Jim Smith edits the canvas app he will be editing version 4. O
A. Mastered

B. Not Mastered
Answer: A
Explanation:

A screenshot of a computer Description automatically generated with low confidence
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Box 1: No

They can only use the app. Box 2: Yes

Box 3: No

You would need to publish Version 2 to make it live.

Note: If you want to publish the restored version, select Publish this version, and then select Publish this version when prompted to confirm.
Graphical user interface, table Description automatically generated

iy Publish this version

Versions nnection a
It's only possible to réstore app Vertions that werd created inthe last s months. Léam mose
Version Maodified Maodiflied by Power Apps release Published
ﬂ' Version 5 - ErRr02n, 2256 M System Administrator 3 2M0r3ET
Version 4 B2l 21242 P Systemn Admarustra 2107327 Live
Version 3 B/Q 20210, 21231 PM ‘E-_.-.‘.-Q--r Admarystrator T3.27
Version 2 + Brard0x, 21220 PM Sesterm Admuristratos 3 21073.27
Version 1 B/9/ 2021, 21204 PM Systermt Admmistrator

Notice the published restore version that shows up as Live.
Graphical user interface, application Description automatically generated

Version Modified Modified by Power Apps release Published
[/ Version 5 e BIO2021 22256 PM System Administratos 32107327 Live
Box 4: Yes

The most recent version of any app is available only to those who have edit permissions for it. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/share-app https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/restore-an-app
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/save-publish-app

NEW QUESTION 47

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You are creating a canvas app.

You need to automatically detect bicycles in pictures taken with the camera. Proposed solution:

> Create an Object Detection custom model in Al Builder.
> Train the model with pictures of bicycles and then publish the trained model.

> Add the Object Detector control to your canvas app.
Does the solution meet the goal?

A. Yes
B. No

Answer: A

Explanation:
To train an object detection model to recognize your objects, you have to gather images that contain those objects.
The first thing you'll do when you create an Al Builder object detection model is to define its domain. Upload images

Then Train and publish your object detection model
The object detector component takes a photo or loads an image file to do an object detection scan. On a mobile device, the user chooses between taking a photo

or selecting one already available in the device user interface. When an image is selected, the component automatically scans it to identify objects.

Reference:
https://docs.microsoft.com/en-us/ai-builder/prediction-overview https://docs.microsoft.com/en-us/ai-builder/object-detector-component-in-powerapps

NEW QUESTION 48

- (Exam Topic 3)

You are developing an app for a package delivery company. Delivery team members will use the app on their phones. Distribution center team members will use a
web-based version of the app that runs on tablet devices.

When a delivery person arrives at a location and the package recipient is present, the app must capture the recipient's signature. If the recipient is not available,
the app must capture a picture of the drop-off location or the person receiving the package.

You need to design phone-based and web-based versions of the app.

Which app type and media control should you use? To answer, configure the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.
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Tree view Jeal o
j S I 3 :""': Barcode scanner
|@
. .{r} :'I' P+ ' )
[ 1Screen’
AR
" -l.-. 4 : u
A. Mastered

B. Not Mastered
Answer: A

Explanation:

Graphical user interface, application Description automatically generated

App Type: Screens

To insert the Camera control in your PowerApps program you can use the blank screen, and select Insert->Media->Camera.

Media Type: Camera

Use the Camera control to capture pictures with a device's camera. The device must have a camera and the user must authorize the app to use the camera.
Tap or select the camera control to capture a picture from the camera.

The most recently captured picture is available through the Photo property. With this property, the images can be:

> Viewed with the Image control. Use the Image control to view the captured image.
> Temporarily put in a variable or a collection.
> Stored in a database.

> Transmitted as a base64 encoded text string.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/controls/control-camera

NEW QUESTION 51

- (Exam Topic 3)

DRAG DROP

You develop Microsoft Power Platform solutions for Contoso, Ltd You create a Power Virtual Agents chatbot in a Microsoft Teams team.

You need to make the chatbot available to all users in your organization.

Which three actions should you perform in sequence? To answer, move all actions from the list of actions to the answer area and arrange them m the correct
order.

Actions Angwer arga

AJCEES the Chatbol m the [eames app 5i0me in Thé Bl Dy yOur Sodleaguts Cale

nthe Ahartet

Atrest the chathot i the Teamd app sore m the Bult for Contoso Cateqe

©

O

A. Mastered
B. Not Mastered

Answer: A

Explanation:
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Actions b e Angwer area
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- e e e e e O S e e e e e e e e e e e e e o

Suberat the chathot for admn approval |
______________________ I

NEW QUESTION 54

- (Exam Topic 3)

You have a solution that contains a Power Automate flow, an environment variable, and a model-driven app.

Which three steps should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

Actions Answer Area

Select the managed solution.

Adjust the version number.
Publish all changes.

Select the unmanaged solution.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Step 1: Adjust the version number. Step 2: Select the managed solution.

Managed Solution: A managed solution is a finalized solution that can be distributed and installed. They are

created by exporting an unmanaged solution by setting restrictions to prevent any further customizations. The whole point of Managed is locking down the
Component states so they cannot be edited. Deleting the Managed Solution will remove all its customisations as well as data contained. Managed Solutions
become read only once deployed so they cannot be manipulated.

Step 3: Publish all changes. Reference:

https://powerusers.microsoft.com/t5/Power-Apps-Pro-Dev-1SV/Managed-vs-Unmanaged/td-p/495685

NEW QUESTION 55

- (Exam Topic 3)

HOTSPOT

A bicycle shop uses Microsoft Dataverse to track bicycle rentals and renter information. The bicycle shop has a standalone tablet with a canvas app. Renters use
the app to check out bicycles. Only one renter at a time can check out bicycles.

Multiple renters can rent as a team. You must expand the app to allow team rentals in one step. All team members must be registered under a single phone
number.

You need to modify the canvas app to display team and team member information, along with bicycle information

Which Ul elements should you use for each requirement? To answer, select the appropriate options m the answer area

NOTE: Each correct selection is worth one point.

Answer Area
Requirement Ul element
Fhone number lookun ¢ - 7 |
= = —_f .I
‘_,I' rlr .
'-".l'_'- Ir I A
..._ arm members 3nd Thair Dicycley | ’ :_'_|
v,
Lis? bo
Jati Lable
A. Mastered

B. Not Mastered

Answer: A
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Explanation:
Answer Area

Requirement Ul element

Sy alar Lo =
“ROne numbear | Kup I - =
-

MM MeEmbers and the Dicycles | G =

NEW QUESTION 59

- (Exam Topic 3)

You have a model-driven app that has an entity named Marinas. You have an entity named Boats that list the boats associated with each marina.

You must add a list of boats to the Marinas form. You must also add an option for users to select different views including boat owners and marina members.
You need to embed the list of boats associated with a Marina record in the entity form.

In which order should you perform the actions? To answer, move all actions from the list of actions to the answer area and arrange them in the correct order.

Actions Answer Area

Add a Subgrid component to a form

Select Show related records and then
select the related entity and default view
for the subgrid

Save and publish the form @ @

Select the Allow users to change
view option

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Graphical user interface, text, application Description automatically generated

Step 1: Add a Subgrid component to a form

You add a subgrid component the same way as you add any other component.

Step 2: Select Show related records and then select the related entity and default view for the subgrid Configure a subgrid component.
Properties available to configure when using a subgrid component on a form using the form designer include:

> Show related rows

When selected, the subgrid displays only rows related to the current row that is displayed on the form.

Step 3: Select the Allow users to change view option

Configure a subgrid component.

Properties available to configure when using a subgrid component on a form using the form designer include:

> Allow users to change view

When selected, app users can change from the Default view to another view of the table selected in the Table property.
Step 4: Save and publish the form Reference:
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/form-designer-add-configure-subgrid

NEW QUESTION 63

- (Exam Topic 3)

You create an app with multiple screens.

Test users report that the size and type of gallery displayed on each screen are different. You must improve the consistency for the app screens.
You need to create a reusable gallery that displays information based on the current record. Which three actions should you perform?

NOTE: Each correct selection is worth one point.

A. Add a gallery control
B. Add an input property
C. Create a component
D. Create a form

E. Add a screen

F. Add an output property
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Answer: ABC

Explanation:
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-gallery https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/create-component

NEW QUESTION 66

- (Exam Topic 3)

You create a dashboard in Power Bl. You share the dashboard with the sales team. Sales team members report that they can see information for the entire
company. You need to ensure that the team is able to see only data for their team.

Where must you configure this restriction?

A. Dashboard
B. Report

C. Dataset

D. Settings

Answer: C

Explanation:

Restrict access to the dataset.

Note: Another way of setting access is through manage permission in the dashboard, report, or dataset. If you share a dashboard, by default the report and the
dataset will also be shared as read-only for users.

Reference:

https://radacad.com/dashboard-sharing-and-manage-permissions-in-power-bi-simple-but-useful

NEW QUESTION 71

- (Exam Topic 3)

DRAG DROP

You are designing a new model-driven app for salespeople at a company.

The company requires that all new line-of-business apps must use a much native functionality as possible to avoid having developers maintain code.

You need to determine how to implement the app s business logic.

Which method should you use? To answer, drag the appropriate methods to the correct requirements. Each method may be used once, more than once, or not at
all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Methods Answer Arca
Miess muld Requirement Method
¢ Al ' .| e 14 L. n the &
i [ ] N |
Business process M f R e APE T rate the
I AT k ¥ T3 T
A. Mastered
B. Not Mastered
Answer: A
Explanation:
Methods Answer Area
Reguirement Method

NEW QUESTION 74

- (Exam Topic 3)

You design a canvas app for users to search thousands of records. You select a data source that supports

delegation to optimize performance. You need to create the app so that it takes advantage of the delegable functionality of the data source. What should you do?

A. Run multiple processes simultaneously.

B. Use the query functions the data source provides.

C. Use the data returned from the data source in multiple languages.
D. Connect to the same data source as different users at run time.

Answer: B

NEW QUESTION 76

- (Exam Topic 3)

A company has 500 products. Each product is referenced by a product ID. Each product belongs to one of eight product categories.

You are creating an app to manage requests for new products.

The product categories will never change. Categories are defined in the column itself, not in a separate table. The data must be structured in a way that does not
allow for misspellings.
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Only two new tables should be created in Microsoft Dataverse:
> Products: Holds the products that can be requested.

> Requests: Holds the requests for the product ID and quantity. The products are filtered by product category.

You need to identify the data types to use when building the table columns in Dataverse.

Which data type should you use? To answer, drag the appropriate data types to the correct requirements. Each data type may be used once, more than once, or
not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Data types Answer Area
Lookup Scenario Data types
Choice Create a column in the Products table that displays the Data type
- — categoryof theproduet @~ TTTTTTTTTTTTTTTTTTTTY
Text . :
Create a column in the Products table for the product Data type
ID of the product ~ TTTTTTTTTeeeS =
Create a column in the Requests table that allows the | Data type

user to select form a list of available products

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: Text

Text columns can contain text characters. This column type has several format options that will change the presentation of the text.

Box 2: Lookup

When you create a new lookup column you are creating a new Many-to-One (N:1) table relationship between the table you’re working with and the Target Row
Type defined for the lookup.

Box 3: Choice

You can customize forms (main, quick create, and quick view) and email templates by adding multi-select columns that are called Choices. When you add a
choices column, you can specify multiple values that will be available for users to select. When users fill out the form, they can select one, multiple, or all the
values displayed in a drop-down list.

Reference:

https://docs.microsoft.com/en-us/powerapps/maker/data-platform/types-of-fields

NEW QUESTION 77

- (Exam Topic 3)

You have a canvas app that uses multiple inputs for calculations.

You must use Test Studio to create automated tests and confirm that the app works as expected. You need to organize your test scenarios into a hierarchy.

In which order should you create the objects? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the correct
order.

Actions Answer Area

Test assertions

Test steps @
Test suites @

Test cases

®
©

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Text Description automatically generated with medium confidence

Step 1: Test suites

By default, a test suite and test case are created for you in Test Studio. Test suites are used to organize your test cases. An app can contain one or more test
suites.

Step 2: Test cases

Depending on how you want to organize or group your tests, you can create multiple test cases in a test suite. Each case can test a specific feature or a subset of
functionalities in your app.

Step 3: Test steps Step 4: Test assertions

A test case consists of test steps that contain actions. Test actions are written using Power Apps expressions that perform a task. You can use the recorder to
automatically generate the test steps as you interact with your app. After you record, you can update the test case, add new steps, delete steps, and write test
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assertions to validate the result of your test.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/working-with-test-studio

NEW QUESTION 82

- (Exam Topic 3)

A clothing retailer is creating a Power Virtual Agents chatbot in Microsoft Teams. The chatbot will use Microsoft Dataverse for Teams to provide sales metrics by
store.

A user wants to be able to ask the chatbot to see all the sales for pants.

You need to configure the chatbot to provide sales data for pants even when a user enters the terms jeans, slacks, or trousers.

Which chatbot component should you use?

A. Skills

B. Tables

C. Topics

D. Supported languages
E. Entities

Answer: E

Explanation:
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

NEW QUESTION 87

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You are developing a model-driven app that uses a Common Data Service database. App users will have a variety of different security roles.

Development and testing must be performed using production data. Multiple testers must be used at each testing stage.

You need to provision and configure new environments for development and testing. Solution:

> Provision a trial environment named T1 and a sandbox environment named S1.
> Copy the production environment to T1 and S1.

> Use T1 for development and S1 for testing.
Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation:

Using trial environments, companies and customers can try out new features and solutions. Do not use a trial environment for development.

A sandbox environment is any non-production environment of Microsoft Dataverse. Isolated from production, a sandbox environment is the place to safely develop
and test application changes with low risk.

Reference:

https://docs.microsoft.com/en-us/power-platform/admin/trial-environments https://docs.microsoft.com/en-us/power-platform/admin/sandbox-environments

NEW QUESTION 92

- (Exam Topic 3)

You store data about products in two Microsoft Excel worksheets. The data contains duplicate rows.

You need to consolidate data from the two worksheets into a Microsoft Dataverse custom table.

In which order should you perform the actions? To answer, move all actions from the list of actions to the answer area and arrange them in the correct order.

Actions Answer Area

Upload the worksheets to OneDrive

Add conditional columns to perform checks on the data

Create queries for the worksheets

Append the output from the queries

Create a dataflow

A. Mastered
B. Not Mastered
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Answer: A

Explanation:

Graphical user interface, text, application, email Description automatically generated

Step 1: Upload the worksheets to OneDrive

A data source needs to be specified. The data needs to be available. Step 2: Create a dataflow

Step 3: Create queries for the worksheets

You can shape your data selection into a form that works best for your table using a Power Query editing experience, similar to the Power Query Editor in Power
Bl Desktop.

Step 4: Add conditional columns to perform checks on the data Step 5: Append the output of the queries

Reference:

https://docs.microsoft.com/en-us/powerapps/maker/data-platform/create-and-use-dataflows https://docs.microsoft.com/en-us/power-query/dataflows/add-data-
power-query

NEW QUESTION 97

- (Exam Topic 3)

DRAG DROP

A company uses Power Apps and Microsoft Dataverse.

The company has three solutions that you must move to a target environment:

* One solution is created for security roles. You must be able to add roles to the solution in the target environment

» One solution is created for table additions and modifications. Table structures must be updated in the solution in the target environment.
» One solution is for customizations. The custom actions must not be modified in the solution in the target environment

You need to create the solutions.

Which type of solutions should you create? To answer, drag the appropriate solutions to the correct requirements- Each solution may be used once, more than
once, or not at all You may need to drag the split bar between panes or scroll to view content.

Solutions Answer Area
unmanaged Requirement Solution
Secunity roles
Managed
Tabibes
IStOmizaions
A. Mastered
B. Not Mastered
Answer: A
Explanation:
Solutions Angwer Area
Unmanaged Requirement Solution
CECLnTy foke Unimanaged
Pl e . : =
ﬁ Fdnr"u_- kL """-r'.F‘l.i:'jn'ZI I
ETOIMLENT RO Managed |

NEW QUESTION 98

- (Exam Topic 3)

HOTSPOT

Users in your company vote on color choices for marketing materials by using the following canvas app:

[}

Users enter color names into a text control and then select Add color to add the color to the Color options radio control. You must remove all the listed colors when
a user selects Clear Selection

You need to implement the functionality.

Which Power Fx formulas should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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Answer Area
Action Power Fx formula
User selects Add color | ifitnrColorValue <> °. CollectiColorList. tatColor Value €
baiColocValue <>, ColiectiColorList, tetColot Value))
1T v alue Tat i Text CodlectiLodorlst, It o Tent))
f{ValuesTaTC odor Color olectiColorlist, taColor Colod
User salacts GEH Sﬂtﬂhﬂ | Rl sger t -1 Alac e . — _ rl st -a . T'_- --J'
:".':-T" radotalac o e ¥F O LIS ~
Reset{radmselecton); Refresh{CoborList)
Revertiradedselecton; Remonvei{ odorList)
A. Mastered

B. Not Mastered
Answer: A

Explanation:
Answer Arca

User solects Clear Selection | Revertiracosalecton Cleal ectiColorList, txt W e .l

NEW QUESTION 99

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You are creating a canvas app.

You need to automatically detect bicycles in pictures taken with the camera. Proposed solution:

> Create a Category Classification custom model in Al Builder.
> Train the model with pictures of bicycles and then publish the trained model.

> Add the Object Detector control to your canvas app.
Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation:
Instead create an Object Detection custom model Reference:
https://docs.microsoft.com/en-us/ai-builder/prediction-overview https://docs.microsoft.com/en-us/ai-builder/object-detector-component-in-powerapps

NEW QUESTION 104

- (Exam Topic 3)

DRAG DROP

A company uses Power Apps.

The company requites a canvas app that connects to the following sources:

* SharePoint list

* Microsoft 365 mailbox

* SOAP API

You need to select connector types.

Which connector types should you use' To answer, drag the appropriate connector types to the correct sources. Each connector type may be used once, more

than once, or not at all You may need to drag the split bar between panes or scroll to view content.

Connector types Answer Area
Srandarnd Custom Sources Connector type
SharePomt kst
Microsch 365 mailbox
SOAP AP
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A. Mastered
B. Not Mastered

Answer: A
Explanation:
Connector types Answer Arca
Srandard Cusiom Sources Connector type
SharePoint st Standard
Microsofi 365 mailbox Standard
COMD AP r
LSO

NEW QUESTION 107
- (Exam Topic 3)
You are creating entities in a Common Data Service database to capture sales data. You create an entity named Sales that includes the following fields:

Field ' Description

' SalesPerson ' The name of the salesperson who made the sale
| Quantity | The number of units sold |
' Rate | The sale price per unit
" GrossAmount | A value obtained by multiplaying the Quantity times the Rate. This value is for |

display purposes only :
' DiscountAmount | An amount that a salesperson enters into the app to discount a sale |
' NetAmount A value obtained by subtracting the DiscountAmount from the GrossAmount

You create a new entity that includes a field named TotalSales. The field is used to capture the aggregated sales for each salesperson.

You need to configure the fields for the entities.

Which field types should you use? To answer, drag the appropriate field types to the correct field names. Each field type may be used once, more than once, or
not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Field types Answer Area
Field name Field type
Rollup
GrossAmount Field type
Calculated
DiscountAmount Field type
Simple
TotalSales Field type
A. Mastered

B. Not Mastered
Answer: A

Explanation:

Box 1: Calculated

Calculated columns are calculated in real-time when they are retrieved. Calculated columns can be composed

using different data types. For example, an Integer calculated column may reference values from Decimal or Currency columns.
Box 2: Simple

A simple column isn’t defined as a calculated or rollup column. Box 3: Rollup

Because rollup columns persist in the database, they can be used for filtering or sorting just like regular columns.

Reference:

https://docs.microsoft.com/en-us/powerapps/developer/data-platform/calculated-rollup-attributes

NEW QUESTION 109

- (Exam Topic 3)

A company uses a model-driven app. You create a Power Bl sales report.

The executive of the company wants all users to see tiles from the report in the model-driven app. You need to ensure all users can see the tiles.
What should you do? To answer, select the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.
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Step Setting

Allow addition of Power Bl visualization tiles v
Power Platform Ernvironment settings
Power Apps settings

Power Bl Semvice settings

Power Bl Desktop settings

Add tiles to a dashboard v
ICreate a personal dashboard

Create a Power Bl dashboard
ICreate a system dashboard

Allow users to view tiles v
Share tile and share dashboard

Share report and share dashboard
Share tile and publish dashboard
Share report and publish dashboard

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Graphical user interface, text Description automatically generated
Box 1: Power Platform Environment settings

Before users can embed Power Bl visualizations on personal dashboards, the organization-wide setting must be enabled.
> In the Power Platform admin center, select an environment.

> Select Settings > Product > Features.

> Under Embedded content set Power Bl visualization embedding to On to enable or Off to disable.

> Select Save.
Box 2: Create a personal dashboard
You can embed Power Bl tiles on your personal dashboard.

> Open your app and go to Dashboards.
> Select an existing personal dashboard or select New to create one.

> On the dashboard, select an area where you want the tile to appear, and then select Power Bl Tile on the toolbar.
> Add new Power Bl tile.

> In the Power BI Tile dialog, select the workspace and then select the Power Bl tile that you want to display on your dashboard. Select Enable for mobile if you
want to make the tile available for Dynamics 365 for tablets and Dynamics 365 for phones.

> Select another area of the dashboard and repeat this step to add another Power Bl tile, or other component, such as a chart or list, to your dashboard.

> Select Save to save your dashboard.

Box 3: Share report and share dashboard.

To share your personal dashboard that contains Power Bl visualizations you must configure sharing in both Dataverse and Power BI, and the user or group must
have the same credentials and appropriate level of access in both services. To share your personal dashboard in your app, go to Dashboards. In the list of
dashboards, select the personal dashboard you want, and then select SHARE DASHBOARD.

Reference:

https://docs.microsoft.com/en-us/power-platform/admin/use-power-bi#embed--visualizations-on-personal-dashb

NEW QUESTION 114
- (Exam Topic 3)
You are creating a capacity planning dashboard with Power Bl desktop.

The dashboard must be able to be used within a model-driven manufacturing planning app as well as be embedded within a Microsoft Teams channel.
The data sources are as follows:

Type of data ' Data source
Sales log that show pending sales by product Microsoft Excel workbook
Work estimates, cost estimates. and start and Common Data Service entity

ending dates for each job activity by emplcyee

Actual work values and associated costs of work | On-premises Microsoft SQL Server-based ERP system

o date by job activity and employee

Employee information On-premises Microsoft SQL Server-based ERP system
You need to determine the appropriate method for accomplishing each task.

Which methods should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.
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Task Method

Connect to the ERP system. v

Use a Data Gateway
Use a Custom Connector
Use a Service Content Pack

Create the relationship between the w
employee file and the work estimates. Create a composite model

Create an aggregated table
Create entity relationships in the CDS Solution Explorer

Create calculations for work remaining, v
remaining budget.

Create a Data Analysis Expressions formula
Create an aggregated table
Create a modeling view

A. Mastered
B. Not Mastered

Answer: A

Explanation:

A picture containing graphical user interface Description automatically generated

Box 1: Use a Date Gateway

You can install an on-premises data gateway on the same local computer as SQL Server (in production, it would typically be a different computer).

Box 2: Create an entity relationship in CDS Solution Explorer You can create relationships with CDS Solution Explorer. Box 3: Create an aggregate table

Rollup columns help users obtain insights into data by monitoring key business metrics. A rollup column contains an aggregate value computed over the rows
related to a specified row. This includes regular tables and activity tables such as emails and appointments.

Reference:

https://docs.microsoft.com/en-us/power-bi/connect-data/service-gateway-sql-tutorial https://docs.microsoft.com/en-us/powerapps/maker/data-platform/create-edit-
entity-relationships https://docs.microsoft.com/en-us/powerapps/maker/data-platform/define-rollup-fields

NEW QUESTION 118

- (Exam Topic 3)

The company is adding a multi-stream interactive dashboard to a model-driven app.

The company requires configuration of the dashboard to filter the table data based on modified accounts over the last month.

You need to configure the filters for the model-driven app dashboard.

Which configuration should you use? To answer, drag the appropriate locations to the correct requirements. Each configuration may be used once, more than
once, or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Configurations Answer Area
Filter by Requirement Configuration
, Configure visual filter attributes that the
Table view dashboard can use.
Filter table Configure the field that the dashboard
uses to filter the table data monthly.
Time frame
A. Mastered

B. Not Mastered
Answer: A

Explanation:

Graphical user interface, text, application Description automatically generated

Box 1: Filter table

Filter Table: The visual filters and global filter attributes are based on this table. Box 2: Filter By

Filter By: The column that the time frame filter applies to. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/configure-interactive-experience-dashbo

NEW QUESTION 122
- (Exam Topic 3)
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Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You are developing a model-driven app that uses a Common Data Service database. App users will have a variety of different security roles.

Development and testing must be performed using production data. Multiple testers must be used at each testing stage.

You need to provision and configure new environments for development and testing. Solution:

> Provision sandbox environments named S1 and S2.
> Copy the production environment to both S1 and S2.

> Use S1 for development and S2 for testing.
Does the solution meet the goal?

A. Yes
B. No

Answer: A

Explanation:

A sandbox environment is any non-production environment of Microsoft Dataverse. Isolated from production, a sandbox environment is the place to safely develop
and test application changes with low risk.

Reference:

https://docs.microsoft.com/en-us/power-platform/admin/environments-overview

NEW QUESTION 126

- (Exam Topic 3)

You complete work on a new canvas app in a development environment and add the app to a solution. You export the solution from the development environment
and import the solution into a production environment.

After several days you notice that the background color for the canvas app in the production environment has changed from white to grey.

You need to determine why the background color changed.

What are two possible causes for the background color change? Each correct answer presents a complete solution.

NOTE: Each correct selection is worth one point.

A. You recently changed the Office 365 theme.

B. You exported a managed copy of the solution and imported the solution as an unmanaged solutio

C. You modified the canvas app in the unmanaged solution.

D. You exported and imported an unmanaged copy of the solution and a co-worker modified the canvas app.
E. You chose a different theme from the Theme menu inside the canvas app.

Answer: AC

Explanation:

A: You can create a custom look and feel (a theme), for your app by making changes to the default colors and visual elements provided in the uncustomized
system.

C: Unmanaged Solution: The beginning state of solution is the unmanaged solution state. During this phase, you can add, edit, update, remove, delete, and test
any of the components of the solution. You also have the ability to create restrictions on the components within the solution.

Note: Managed Solution: A managed solution is a finalized solution that can be distributed and installed. They are created by exporting an unmanaged solution by
setting restrictions to prevent any further customizations. The whole point of Managed is locking down the Component states so they cannot be edited.
Reference:

https://powerusers.microsoft.com/t5/Power-Apps-Pro-Dev-ISV/Managed-vs-Unmanaged/td-p/495685 https://docs.microsoft.com/en-us/powerapps/maker/model-
driven-apps/create-themes-organization-branding

NEW QUESTION 128

- (Exam Topic 3)

You have a Power Platform solution that uses Common Data Service. You need to secure all fields that support field-level security.
Which field can you secure?

A. createdon

B. accountid

C. owninguser

D. cr7b_accountid

Answer: D

Explanation:

Which fields can be secured?

Although most attributes can be secured, there are system attributes, such as IDs, timestamps, and record tracking attributes, that can't. Below are a few examples
of attributes that can't be enabled for field security. ownerid, processid, stageid, accountid, contactid

createdby, modifiedby, OwningTeam, OwningUser

createdon, Entitylmage_Timestamp, modifiedon, OnHoldTime, overriddencreatedon statecode, statuscode

Reference:

https://docs.microsoft.com/en-us/power-platform/admin/field-level-security

NEW QUESTION 133

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You are creating a canvas app.

You need to automatically detect bicycles in pictures taken with the camera. Proposed solution:
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> Create a Category Classification custom model in Al Builder.
> Train the model with pictures of bicycles and then publish the trained model.

> Add the Object Detector control to your canvas app.
Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation:
Instead create an Object Detection custom model Reference:
https://docs.microsoft.com/en-us/ai-builder/prediction-overview https://docs.microsoft.com/en-us/ai-builder/object-detector-component-in-powerapps

NEW QUESTION 138

- (Exam Topic 3)

A company is using Power Virtual Agents in Microsoft Teams to expose Microsoft Dataverse data to employees.

You create a chatbot that retrieves a list of customers by postal code from a Dataverse table. The chatbot will accept requests from a user and must connect to
Dataverse to retrieve the data.

You need to connect the chatbot to the Dataverse table. What should you use?

A. Table

B. Power Apps

C. Microsoft Teams

D. Power Virtual Agents
E. Power Automate

Answer: C

Explanation:

Dataverse for Teams is the “lite” version of Dataverse. It is a low-code platform designed to build relatively simple (but still powerful) apps, using a user-friendly
interface and remaining within Microsoft Teams. This new update means that users now have the possibility to create Power Apps apps, Power Automate flows
and Power Virtual Agents bots without leaving the Teams platform.

Reference:

https://docs.microsoft.com/en-us/learn/paths/work-power-platform-teams/
https://docs.microsoft.com/en-us/learn/modules/create-chatbot-power-virtual-agents-dataverse-teams/5-call-acti

NEW QUESTION 141

- (Exam Topic 3)

You create a custom field on the Account entity.

Members of TeamA must have full access to the field. Members of TeamB must have no access to the field. You need to configure security.

Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

Actions Answer Area

Add TeamA to the field security profile.

Create a field security profile and set all the
permissions for the custom attribute to Yes.

Add TeamB to the field security profile.

Create a field security profile and set all the
permissions for the custom attribute to No.

Enable field-level secunty for the field.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Step 1: Enable field security for the field

Step 2: Create a field security profile and set all the permissions for the custom attribute to Yes.

Step 3: Add TeamaA to the field security profile.

Note: Field-level security is available for the default fields on most out-of-box entities, custom fields, and custom fields on custom entities. Field-level security is
managed by the security profiles. To implement field-level security, a system administrator performs the following tasks.

> Enable field security on one or more fields for a given entity.
> Associate one more existing security profiles, or create one or more new security profiles to grant the appropriate access to specific users or teams.

NEW QUESTION 142
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- (Exam Topic 3)

You create a new solution publisher and include a publisher prefix value.

Which two actions can you perform? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. You can change contact details of a publisher after you create the publisher

B. When you change a solution publisher prefix, you can change the schema name for existing components
C. You can change the schema name of a publisher after creating the publisher

D. You can add a component from one solution to another solution that has a different publisher

Answer: AD

Explanation:

Once you introduce a publisher for a component in a managed solution, you can’t change the publisher for the component.
Reference:

https://docs.microsoft.com/en-us/power-platform/alm/solution-concepts-alm#solution-publisher

NEW QUESTION 147

- (Exam Topic 3)

DRAG DROP

A company uses Microsoft Power Platform in a production environment. The company is defining new business processes in a prototyping environment. You
create components in both environments.

You need to package the components you create.

Which solution types should you use? To answer, drag the appropriate solution types to the connect components. Each solution type may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Solution types Answer Area

L
ed

Component Solution type

ad LArvas app Created in produchon and used on

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Solution types Answer Area

Component Solution type

ARG £ LAfvas app created in production and used only i || Manageo [

NEW QUESTION 152

- (Exam Topic 3)

You are creating a model-driven app that allows users to create and edit a list of existing accounts. You need to display a list of all active accounts.
Which user interface components should you use?

A. view

B. gallery

C. data table
D. form

Answer: C

Explanation:

Imagine that you have a collection of data (such as a list sales orders, a set of service tickets, or a directory of contacts), and that you want to show this data in
your Microsoft PowerApps app in a tabular format, where each column represents a field and each row represents a record. In the past, you might have been able
to roughly simulate this visualization, although the process required some effort. However, we’ve been listening to your requests and are happy to announce that
you can now quickly and easily achieve this very typical visualization by using the new Data table control that has been recently added to PowerApps.

Reference:

https://powerapps.microsoft.com/fr-fr/blog/introducing-the-data-table-control/

NEW QUESTION 155

- (Exam Topic 3)

A company is consolidating communications processes by using Microsoft Teams and Microsoft Power Platform technologies.

A Power Automate flow monitors social media channels to identify high-impact trends.

When the Power Automate flow identifies the trends, consistently formatted and standardized feedback must be collected from the channel members within
Teams.

You need to streamline the Power Automate and Teams communication process. What should you use?
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A. Al Builder

B. Common Data Service business process flows
C. Adaptive cards

D. Integrated approval flows

Answer: A

Explanation:

"Microsoft Power Platform and Al Builder components allowed us to quickly deliver an innovative and

well-integrated solution within our Dynamics 365 platform for our marketing and sales business partners. The platform is a game-changer in this new world of rapid
app delivery."

Jim Parker: Web and Collaboration Services Manager Reference:

https://customers.microsoft.com/en-au/story/810656-hexion-manufacturing-power-platform

NEW QUESTION 158

- (Exam Topic 3)

A company has the following divisions: wholesale and retail.

The manufacturer wants to create a single Power Bl report to allow users to view data from a Microsoft SQL Server database.

You need to ensure that each user sees data only for the team to which the user is assigned. How should you secure the report?

To answer, drag the appropriate options to the correct action. Each option may be used once, more than once, or not at all. You may need to drag the split bar
between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Options Answer Area
Action Option
Power Bl Service
Create the team as a role. Option
Power Bl Desktop
Add members to the role. Option

Common Data Service

Power Platform Admin center

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Graphical user interface, application Description automatically generated

Box 1: Power Bl Desktop

You can define roles and rules within Power Bl Desktop. When you publish to Power BI, it also publishes the role definitions.
To define security roles, follow these steps.

> Import data into your Power Bl Desktop report, or configure a DirectQuery connection.
> From the Modeling tab, select Manage Roles.
> From the Manage roles window, select Create.

> Etc.

Box 2: Power Bl Service

After you save your report in Power Bl Report Server, you manage security and add or remove members on the server.

* 1. In Power Bl Desktop, save the report to Power Bl Report Server. You need to use the version of Power Bl Desktop for Power Bl Report Server.
* 2. In Power Bl Report Service, select the ellipsis (...) next to the report.

* 3. Select Manage > Row-level security.

Graphical user interface, text, application, email Description automatically generated

- Add Member

Edit Group or user

'-.,.' r."'-'l-”-'.:: rl.‘fff"'-IH

Row-level security

On the Row-level security page, you add members to a role you created in Power Bl Desktop. Reference:
https://docs.microsoft.com/en-us/power-bi/create-reports/desktop-rls
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NEW QUESTION 159

- (Exam Topic 3)

Each maker at a company has a separate Common Data Service environment. You are customizing a canvas app. You create two new entities in your
environment.

You are leaving for a vacation. Another maker will continue customizing the app in your absence.

You need to transfer the work to the other maker and ensure that you can work on the updated app when you return from your vacation.

What should you export?

A. ununmanaged solution that includes all customizations
B. the default solution

C. a managed solution that includes all customizations

D. the app

Answer: A

Explanation:

Unmanaged Solution: The beginning state of solution is the unmanaged solution state. During this phase, you can add, edit, update, remove, delete, and test any
of the components of the solution.

Reference:

https://powerusers.microsoft.com/t5/Power-Apps-Pro-Dev-1SV/Managed-vs-Unmanaged/td-p/495685

NEW QUESTION 162

- (Exam Topic 3)

You create a canvas app.

A user is not able to determine which field currently has focus. You run App checker to identify errors. You need to verify that the focused border thickness is set to
a value greater than zero.

Which section of the App checker results should you check?

A. Rules

B. Performance
C. Accessibility
D. Runtime

Answer: C

Explanation:
The Accessibility checker classifies each issue as an error, a warning, or a tip based the issue's severity.
Issues include:

> Focus isn't showing

When the FocusBorderThickness of a control is set to 0. It is good practice to ensure a proper color-contrast ratio between the focus border and the control itself
so it's clearly visible.

Reference:

https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/accessibility-checker

NEW QUESTION 164

- (Exam Topic 3)

You are an app maker. You are creating a canvas app. You do not have access to Power BI.

You need to add charts to the app.

Which three chart types can you add directly to the canvas app? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. pie

B. area
C. funnel
D. column
E. line

Answer: ADE

Explanation:

You can use line charts, pie charts, and bar charts to display your data in a canvas app. Add a bar chart to display your data:
* 1. On the Home tab, add a screen.

* 2. On the Insert tab, select Charts, and then select Column Chart. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/use-line-pie-bar-chart

NEW QUESTION 166

- (Exam Topic 3)

HOTSPOT

The customer service team of a company uses a model-driven app to log customer interactions. The app contains two tables: one to track customer interactions
and one to track products.

The team requires an interactive dashboard to display the activities. The dashboard must display the products that have the most complaints. Each chart must
display the associated data.

You need to create the dashboard

Which features should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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Anvwer Area

Activity Feature
Display customer interactions and products i Sangle-stream dashboard -
Multi-stream dashboard

Sindgli-stream dashibasand
Standard dashboard

Display charts with associated data Default Chadt -

Sheoaw Chart Only
Duiplay Chaet Selection

Dt Chnet

A. Mastered
B. Not Mastered

Answer: A
Explanation:
Answer Area
Activity Feature
Display customer interactions and products I Seng lo-stream dashboard - |

Multi-stream dashboard

Standard dashboard
Dizplay charts with assocated dala Default Chart -

Showy Charl Only
Desplay Chart Selection

Défault Chadt

NEW QUESTION 167

- (Exam Topic 3)

Rangers in national parks report wildlife they encounter during patrols. The rangers record observations in a notebook when they are on patrol. The rangers
manually enter observation data when they are in the office. You are designing an app that allows rangers to record their observations while they are on patrol.
The wildlife is modeled as a custom table named Wildlife. The model has relationships to the annotation entity and to a custom entity named Wildlife Details. In the
Wildlife Details entity, rangers capture more information as they observe an animal’s habitat. When observing wildlife, rangers must indicate whether an animal
requires medical attention. The app must synchronize and save data to Common Data Service when connectivity is available.

You need to design the app.

What should you do? To answer, select the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.

Requirement Action

Enter notes related to wildiife records -

Enable the Wildiife entity and annotation entity for mobile offiine

Enable the attachments entity and the annotation entity for mobile offine

Enable the Wildlife entity for mobile offine and enable attachments on the Wildlife entity
Enable the Wiidife entity for mobile offine and use the timeline control for the Wildlife form

Enter wildlife details as related records v
Allow feedback on the Wiidhfe Details enftity

Enable the Wildiife Details entity for mobile offline

Enable change tracking on the Wildiife Details enbity

Enable attachments on the Wildife Details entity and enable the Wildiife Details entity

for mobile offine

Indicate that an animal requires v
medical attention Create a business rule

Create a business process

Create a Power Automate flow

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: Enable the Wildlife entity and the annotation entity for mobile offline

Note: As part of the 2020 Wave 2 release, we made generally available offline capabilities for model driven apps for users of Power Apps. Makers and
administrators can now configure apps to be available offline on a user’s device, and users can continue to complete their tasks against the local cache on their
phone even with intermittent or no network connectivity. When the network is re-established, the users’ changes are seamlessly synchronized back to the cloud.
Box 2: Enable attachments on the Wildlife Details entity and enable Wildlife Details entity for mobile offline. Box 3: Create a business process.

Business process flows. Ensure that people enter data consistently and follow the same steps every time they work in an app by creating a business process flow.
Note: Power Automate includes several types of processes, each designed for a different purpose:

> Automated flows. Create a flow that performs one or more tasks automatically after it's triggered by an event.
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> Button flows.
> Scheduled flows. Create a flow that performs one or more tasks on a schedule such as once a day, on a specific date, or after a certain time.

> Business process flows. Ensure that people enter data consistently and follow the same steps every time they work in an app by creating a business process
flow.

> Workflows and actions. Dynamics 365 customizers may be familiar with the classic Microsoft

Dataverse processes, which are workflows and actions. Reference:
https://powerapps.microsoft.com/en-us/blog/mobile-offline-for-power-apps/
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/guide-staff-through-common-tasks-proce

NEW QUESTION 168

- (Exam Topic 3)

You plan to create apps for a company.

You need to identify the Power Platform tools required.

What should you use? To answer, drag the appropriate tools to the correct requirements. Each tool may be used once, more than once, or not at all. You may
need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Tools Answer Area

Power Virtual Agents bot Requirement Tool
Create an app with a customized user interface that

Power Automate allows users to quickly create support tickets.

Canvas app Create an app that uses a quided business process to
navigate through all records associated with a support
ticket

Model-driven a : .
i Send an email to a customer support manager every time

a support ticket is created.

Create an automated chat tool that guides a customer
through the support ticket creation process

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Box 1: Canvas App
Box 2: Model-driven app

Model-driven app design is a component-focused approach to app development. Model-driven app design doesn’t require code and the apps you make can be
simple or very complex. Unlike canvas app development where the designer has complete control over app layout, with model-driven apps much of the layout is
determined for you and largely designated by the components you add to the app.

Box 3: Power Automate

Power Automate is a service that helps you create automated workflows between your favorite apps and services to synchronize files, get notifications, collect
data, and more.

Box 4: Power Virtual Agents bot
When you create bots with Power Virtual Agents, you author and edit topics.

NEW QUESTION 169
- (Exam Topic 3)
A company uses Microsoft platforms for all accessibility, compliance, and security auditing.

The auditing and compliance division of the company flags a newly created Power Apps canvas app due to accessibility issues. The app must be unpublished until
it conforms to Microsoft accessibility requirements and recommendations.
You need to identify all accessibility issues for a solution. What should you use?

A. Microsoft Accessibility Conformance Reports
B. Microsoft Compliance Center

C. Power Apps Studio

D. Microsoft Accessibility Guides

E. Microsoft Visual Studio

Answer: C

Explanation:

> Find accessibility issues

> In the upper-right corner of Power Apps Studio, select the icon for the App checker.
> App checker icon.

> In the menu that appears, select Accessibility.

> A list of issues appears, sorted first by severity and then by screen.

> Select the arrow next to an item to show details about it.

> Accessibility checker details.

> Select the back arrow to return to the list of items.

> If you decide to address an issue, select it to open the affected property.
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> After you change one or more properties, select Re-check to update the list of issues. Resolved items disappear from the list, and new items may appear.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/accessibility-checker https://support.microsoft.com/en-us/accessibility/enterprise-answer-desk

NEW QUESTION 170

- (Exam Topic 3)

You create a canvas app within a Power Platform environment.

You need to identify potential accessibility issues for the canvas app before making the app available to other users.
Which tool should you use?

A. Portal Checker
B. App Checker

C. Solution Checker
Answer: B
Explanation:

Find accessibility issues
* 1. In the upper-right corner of Power Apps Studio, select the icon for the App checker.

YeTs || 3 A S

* 2. In the menu that appears, select Accessibility.

App checker X

Formulas p

Accessibility (5) >

A list of issues appears, sorted first by severity and then by screen. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/accessibility-checker

NEW QUESTION 175

- (Exam Topic 3)

A company uses Power Apps in a single Microsoft Dataverse environment.

Users are divided into two groups about not a canvas app should work. The company decides that each group of users will try a version of the app for one week
and switch to the other version of the app the following week.

You need to manage the app creation. What should you do?

A. Create one app with two different version numbers.
B. Create one app with two different version notes.

C. Create two apps with the same name.

D. Create two apps with different app names.

Answer: D

NEW QUESTION 176

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

A company has locations in multiple countries and regions across four continents.

The company stores the total amount of each order in the local currency of the country/region where the customer is located. The company stores the applicable
exchange rates in a custom US dollars (USD) exchange rate table.

You need to create a visualization that displays the total amount of orders by country/region in USD. Proposed solution:

Create a custom calculated field of type currency on the order table that converts the order total to USD and displays the total amounts by region in a Power Bl
chart.

Does the solution meet the goal?

A. Yes
B. No

Answer: A

Explanation:

Instead use a calculated field.

Need to calculate the exchange rate in USD.

Calculated columns are calculated in real-time when they are retrieved.

Reference:
https://docs.microsoft.com/en-us/powerapps/developer/data-platform/calculated-rollup-attributes

NEW QUESTION 178
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- (Exam Topic 3)
You are configuring security to enable users to analyze data by using Microsoft Excel templates.
You create a security role named TemplateAdministrator and configure the role as shown below and assign the role to a user named Userl.

Power Apps
d .‘_;] Save and Close 'f..'i Y Actions = & Help =

Security role: TemplateAdministrator Working on solutions: Default Solution

Details  Core Records  Marketing Cales  Service Bussireess Management Senace Management  Customazation  Missing Entities Business Process Flows  Custom Entitees

Entity Create Read Write Delete Append  Append To Assign Share
Business Unit 9
Channel Property Group [ ] @ &

Currency ® L ]

Document Template

Mailbox Auto Tracking Folder

Organization [ ]

Personal Document Template ®

Privacy Related Privileges
Enabling these privileges will allow users to extract customer data from Microsoft Dynamics 365. For more information, review the comesponding user documentation.

Documient Generation @ Dynamics 365 for mohile @
Export to Excel Go Offline in Dutlook @
Mail Merge [ ] Print '
Sync to Outlook ) Use Dynamics 365 App for Outlook &
Miscellaneous Privileges
Act on Behalf of Another User Bpprove Email Addresses for Users or Queues
Assign manager for & user Assign position for a user
Assign Territory to User ) Bulk Edit

Key

Hone Selected User Business Unit & Parent: Child Business Unit @ COrganization

Use the drop-down menus to select the answer choice that answers each question based on the information presented in the graphic.
NOTE: Each correct selection is worth one point.

You need to ensure that User1 can see the pre-configured example templates.

Which permission should you change?

Bulk Edit

Export to kExcel

Read on Document Template

Read on Personal Document Template

You need to ensure that User1 can download the file to create an Excel template,
Which permission should you change?

Bulk Edit

Export to Excel

Read on Document Template

Read on Personal Document Template

A. Mastered
B. Not Mastered

Answer: A

Explanation:
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You need to ensure that User1 can see the pre-configured example templates.
Which permission should you change?

Bulk Edit

Export to Excel

Read on Document Template

'Read on Personal Document Template

You need to ensure that User1 can download the file to create an Excel template.
Which permission should you change?

Bulk Edit

Export to Excel

Read on Document Template

Read on Personal Document Template

NEW QUESTION 180

- (Exam Topic 3)

DRAG DROP

A company is creating Power Apps apps for their customer service team.

You must create a final released solution to export to their test environment that cannot be changed in the new environment.

You need to determine the types of solutions to use.

Which type of solution should you use? To answer, drag the appropriate solution types to the correct conditions. Each solution type may be used once, more than
once, or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Solution type Answer Area
| Managed Condition Solution type
Unmanaged Assign a publisher for the first time Solution type
Export the solution Solution type
A. Mastered

B. Not Mastered
Answer: A

Explanation:

Graphical user interface, application Description automatically generated

Box 1: Unmanaged

Unmanaged solutions are used in development environments while you make changes to your application. Box 2: Managed
Managed solutions are used to deploy to any environment that isn't a development environment for that solution.
Reference:

https://docs.microsoft.com/en-us/power-platform/alm/solution-concepts-alm

NEW QUESTION 185

- (Exam Topic 3)

You are configuring a new Common Data Service environment by using the Power Apps Maker portal. You need to create an entity that uses the prefix xyz.
Which four actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.
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Actions Answer Area
Create an entity in the new solution.

Enter the entity Display Name and use the existing prefix.
Add a new solution.
Enter the entity Display Name and modify the prefix to xyz.

Add a new pl.jlj'lis'i'ier with the prefi;-: XyzZ.

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/data-platform-create-entity

NEW QUESTION 186
- (Exam Topic 3)
You use a Microsoft SharePoint list to record information about customers.

You must perform a series of actions only when a new item is added to a SharePoint list. You need to configure a Power Automate flow.
Which trigger should you use?

A. When an item is created

B. When an item is created or modified
C. When afile is created (properties only)
D. For a selected item

Answer: A

Explanation:
Trigger - When an item is created Triggers when an item is created.

MS Flow will trigger when an item is created in the list. It will return all list item properties which can be used in the Flow.
Reference:

https://www.c-sharpcorner.com/article/sharepoint-based-triggers-in-ms-flow-part-2/

NEW QUESTION 187
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